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very release of Windows Server has offered numerous features and

functionality to assist administrators and companies with their
day-to-day tasks. Each new release has offered plenty of new func-
tionality but has also increased the administrative burden for the serv-
ers. Windows 2000 Server laid the foundation for Active Directory.
Windows Server 2003 became the first dedicated server platform from
Microsoft. Windows Server 2008 sought to offer server flexibility by
providing role-based deployment including streamlined new roles such
as Server Core.

Windows Server 2012 is a revolutionary release of the operating sys-
tem. While Windows Server 2012 continues to build on prior releases, it
delivers improvements to the Microsoft Windows Server platform. From
the game-changing Hyper-V addition of shared-nothing live migra-
tion (you will learn more about that in Chapter 14, “Maintaining Your
Virtual Servers”) to better server management capabilities (you can now
easily manage multiple servers from one console) and improvements
designed to work with Windows 8, Windows Server 2012 has a lot to
offer.

However, even with the addition of all these capabilities, Windows
Server 2012’s true benefits still are for administrators and were designed
to improve the day-to-day tasks of administrators.

Before you begin to dig into the day-to-day improvements of admin-
istrative tasks, you should understand how the server was built so you
can properly administer it. Do you need to install a new server? Do you
need to perform an in-place upgrade? Do you migrate existing services
such as DNS, Active Directory, or printers? These vital questions need
to be answered so you can start to take advantage of the administrative
improvements in Windows Server 2012. This chapter will take a brief
look at planning, installing, and upgrading to Windows Server 2012.
You will also learn about installing the migration tools.

Plan for Windows Server 2012

You have probably heard this phrase a thousand times (well, make this
a thousand and one): “If you fail to plan, you plan to fail.” Having a
solid idea what role the server will play is important to the health of IT
as well as to your sanity. Some of the decisions you make during the
planning process can impact the installation phase. If your planning
is off, your installation will be off. Although fixing most installation
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problems can be straightforward, some can become quite complex
to fix, if not completely irreversible. Everyone has done the “FDISK,
format, reboot” dance of destruction at least once to fix the wrong
decisions.

In this section, you will look at the hardware requirements and
recommendations for a Windows Server 2012 server installation. You
will also learn about the roles and features that a Windows Server
2012 server can perform. In addition to the resources mentioned in
this chapter, Microsoft offers several free tools to assist you in your
planning process. These assessment tools are included in the Microsoft
Assessment and Planning (MAP) Toolkit:
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http://technet.microsoft.com/en-us/solutionaccelerators/
dd537566.aspx?SA_CE=NOT-MAPBETA-SITE-TNETWINSVR-20090615

Understand Hardware Requirements

Like its predecessors, Windows Server 2012 offers numerous roles and
editions of the server operating system. Just like Windows Server 2008
R2, Windows Server 2012 will be released only in 64-bit versions.
This means before you even start, you need to have the proper hard-
ware to support the operating system. This requirement will also dic-
tate upgrade and migration paths. Table 1.1 shows the base hardware
requirements for Windows Server 2012.

Table 1.1: Windows Server 2012 Minimum Hardware Requirements

Resource Requirement

Processor 1.4GHz x64 processor
Memory 512MB RAM

Drive space 32GB

Drive DVD-ROM

Display and others Super VGA 800 x 600 or higher

Keyboard and mouse

These recommendations are the bare minimum needed to get the
server up and running. See Table 1.2 for additional recommendations
for processor memory and hard drive space. They will offer a base sys-
tem with solid performance and flexibility for additional functions.
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Table 1.2: Additional Hardware Recommendations

Resource Recommendation
Processor 2GHz x64 dual-core processor
Memory 4GB RAM

Drive space 100GB

You should always look at the base requirements as the bare mini-
mum to get the server operating system up and running. Generally
speaking, these minimum requirements do not take into account the
workload you will be placing on the server. You should always consider
the roles and applications that will be loaded on the server. You should
consider the recommendations and requirements for those applications
as additional resources to those listed in Table 1.1. This will allow you
to have servers that will perform satisfactorily and meet your needs,
while having a little room to grow.

If the server is going to be used for virtualization workloads, ensure
you have enough RAM and processor cores to support the Windows
Server 2012 operating system as well as the virtual servers running on
the server. How many servers, what types of servers, and what types
of applications are all factors you need to review carefully when you’re
planning a virtualization server. One last note of concern for a virtual-
ization server: Whether you choose VMware or Hyper-V virtualization
technologies, make sure your processor hardware supports hardware-
assisted virtualization. Either AMD Virtualization (AMD-V) or Intel
Virtualization Technology (Intel VT) will work. These technologies
typically also need to be enabled in the BIOS because they are generally
not enabled by default. Enabling the virtualization normally requires a
full hard reboot to take effect. Make sure you enable these technologies
before installing your virtualization technology. In Chapter 14, you will
learn more about Hyper-V.

Understand Windows Server 2012 Editions and Roles

Windows Server 2012 streamlined the number of editions to four. This
book focuses on the Datacenter and Standard editions. One important
note is that both editions (Datacenter and Standard) are technically the
same; they both provide the full technical capability of the Windows
Server 2012 platform. The difference between the Datacenter and



Plan for Windows Server 2012

Standard editions involves licensing virtual operating systems. (We
will cover those in the “Consider Your Licensing Options” section in
this chapter.) Table 1.3 gives an overview of the Windows Server 2012
editions.

Table 1.3: Windows Server 2012 Editions

Edition Overview

Datacenter Designed for large-scale highly virtualized infrastructures. Ideal for pub-
lic, private, and hybrid cloud deployments.

Standard Designed for nonvirtualized environments where physical server deploy-
ment is preferred. Great for smaller infrastructures or branch offices.

Essentials Geared toward small business environments. Includes built-in configura-
tions to connect to cloud-based services. Limited to 25 users.

Foundation Provides general-purpose Windows Server functionality. Limited to 15
users.

Once you have chosen the right edition for your needs, you need to
look at the services the server will provide for your infrastructure. These
services come in the form of roles. Windows Server 2012, like Windows
Server 2008 R2, provides several server roles that can be installed on the
server. A role is a set of software features and functions that provides
services for your server and infrastructure. Some of these roles require
additional planning to provide a stable and reliable environment.

Table 1.4 describes the server roles.

Table 1.4: Windows Server 2012 Server Roles

Role Function

Active Directory Certificate  Allows for the creation of certificate authorities. This role
Services (AD CS) allows you to host your own Public Key Infrastructure (PKI)
on the server.

Active Directory Domain Provides single sign-on (SSO) capabilities for your network

Services (AD DS) and network services. This allows for the creation of
objects (users, groups, computers, and so on) for use with
network authentication and authorization.

Active Directory Provides single sign-on capabilities across multiple forests
Federation Services and domains. Additionally, this role provides web single
(AD FS) sign-on.

7
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Table 1.4: Windows Server 2012 Server Roles (continued)

Role

Function

Active Directory
Lightweight Directory
Services (AD LDS)

Active Directory Rights
Management Services (AD
RMS)

Application Server

DHCP Server

DNS Server

Fax Server

File and Storage Services

Hyper-V

Network Policy and Access
Services

Print and Document
Services

Remote Access

Commonly referred to as ADAM, this role is a lightweight
version of AD DS. It allows for the storage of a base direc-
tory used for specific applications.

Allows you to provide authorization and verification services
to users to access protected content.

Provides the ability to have high-performance distrib-
uted applications (mainly applications that use the .NET
Framework).

Provides automatic TCP/IP address services for your
network.

Provides name and service resolution services for TCP/
IP networks. This is a core component for AD DS, and it is
highly recommended you use this built-in service for your
domain controllers.

Allows basic fax functions to be hosted on the server, such
as sending, receiving, and reporting.

Provides many services for the file system, including replica-
tion, managing shares, and faster file searches. This role
also provides services for UNIX clients to access files on the
server.

Provides the ability to create, manage, and perform live
migration of virtual machines. Virtual machines operate on
the host machine and are servers without the hardware.

Provides resources for routing and remote access. This ser-
vice also provides the framework for Network Access and
Protection (NAP) and DirectAccess. Included in this service
are two core components: Health Registration Authority
and the Host Credential Authorization protocol.

Provides the ability for a centralized print server as well as
management for printers. This service also installs the nec-
essary Group Policy Objects (GPOs) for printer management
through Group Policy.

Provides remote access services for your clients, from
always-on Direct Access to traditional VPN. Additionally
Remote Access provides routing capabilities such as
Network Address Translation (NAT).
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Role

Function

Remote Desktop Services

Volume Activation
Services

Web Server (IIS)

Windows Deployment
Services

Windows Update Services
(WSUS)

Provides the ahility for your users to access the Remote
Desktop Services on your server. These services provide
presentation virtualization for your thin clients. Formerly
called Terminal Services.

Provides the server capability to manage licensing in your
organization for Key Management Services or Directory
Based Activation.

Provides the core infrastructure for a web server.

Installs the services for deploying Windows operating sys-

tems across the network.

Provides the management framework for Microsoft
updates. This service allows you to deploy updates in a
variety of options across your network.

NOTE Table 1.4 gives brief explanations of all the services
available to Windows Server 2012. For more details, please take
a look at Chapter 2, “Adding Server Roles and Functionality.”
You can also get a more thorough explanation of the roles at
http://technet.microsoft.com/en-us/windowsserver/default.
aspx. In Windows Server 2012, some of the roles and features
have been changed under the covers.

Understand Server

Core

Windows Server 2012 Server Core is another installation option that

is worth further mention

. As in Windows Server 2008 and Windows

Server 2008 R2, Windows Server 2012 Server Core is a very stream-

lined version of Windows Server. In Windows Server 2012, Server Core
is now the default installation option. Server Core has limited function-
ality and runs a subset of the roles provided by Windows Server 2012.
Server Core does not have a GUI. This means that all the administra-

tion is performed remote

tantly, the Server Core option is no longer a permanent installation-time
decision; you can add the GUI back later if you want. Unlike Windows

ly or via a command prompt. Most impor-

Server 2008 R2 (where you had to reinstall the server to remove the
GUI), with Windows Server 2012 you can add and remove the GUI

management tools easily.
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This by no means implies that Server Core does not have usefulness
in the network. The Server Core role provides a nice addition to your
network without the overhead of a traditional server. This lowers the
overall maintenance and security risks for the server. Server Core
can also reduce the amount of patching that is required to keep the
server up-to-date, and it is the Microsoft preferred installation for
Windows Server 2012. The server provides support for these
thirteen roles:

® DNS Server
= DHCP Server
= Active Directory Domain Services (AD DS)
= Active Directory Lightweight Directory Services (AD LDS)
= File Services (including File Server Resource Manager)
= Print and Document Services
= Web Server (IIS, including a subset of ASP.NET)
=  Streaming Media Services
=  Windows Server Update Server
= Active Directory Rights Management Server
= Active Directory Certificate Services (AD CS)
= Hyper-V
» Routing and Remote Access Server and the following subroles:
= Remote Desktop Services Connection Broker
= Licensing
= Virtualization

Server Core is one of the two choices during installation, the other
being a Full GUI installation. Additionally, you have a new option
called Minimal Server Interface. The Minimal Server Interface provides
graphical management tools and infrastructure for a hybrid manage-
ment alternative.

Also in Windows Server 2012, if you install the full GUI, you can
add additional desktop components via the Desktop Experience fea-
ture. In Table 1.5, you can see the components included in each of these
choices.
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Table 1.5: Windows Server 2012 Feature Availability by Installation Option

Feature Server Minimal Server Desktop
Core Server with GUI Experience
Interface Feature
Command Prompt Available Available Available Available
Windows PowerShell/ Available Available Available Available
Microsoft .NET
Server Manager N/A Available Available Available
Microsoft Management N/A Available Available Available
Console (MMC)
Control Panel N/A N/A Available Available
Control Panel applets N/A Some Available Available
Windows Explorer N/A N/A Available Available
Taskbar N/A N/A Available Available
Notification area N/A N/A Available Available
Internet Explorer N/A N/A Available Available
Built-in help system N/A N/A Available Available
Themes N/A N/A N/A Available
Windows 8 Shell N/A N/A N/A Available
Windows Store and sup- N/A N/A N/A Available
port for Windows Store
apps
Windows Media Player N/A N/A N/A Available

In the “Perform a Windows Server 2012 Server Core Installation”

section, you will see how to install these different options.

Consider Your Licensing Options

When you install Windows Server 2012 into your environment, you
have to take into account the licensing. Windows Server 2012 for
Standard and Datacenter are licensed per physical processor; each
license covers two processors. For example, if your hardware comes

with four processors, you will need two licenses to properly license the

1
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server. Every Windows Server 2012 requires two types of licenses. First,
you need a server license for the rights to run the operating system, and
second, you need a client access license (CAL) to allow your clients to
access the server. CALs come in two flavors:

»  The device CAL allows access for one device for any user.
s  The user CAL allows access for one user on any device.

Depending on your existing licensing, you may already be covered
for Windows Server 2012. If Windows Server 2012 is solely used for
virtualization servers, you do not need to have CALs for the host oper-
ating system. However, you will still need CALs for the guest operating
systems running on the server. There is only one difference between the
Windows Server 2012 Standard and Datacenter editions, and this is in
regard to how you use virtualization technologies inside your network.
Depending on which edition you have chosen (Standard or Datacenter),
you may not need to purchase server licenses for your virtualized
instances of Windows Server 2012. If you are using Windows Server
2012 Standard edition, you are allowed to run two virtualized instances
of Windows Server 2012 under your server license. If you are using
Windows Server 2012 Datacenter, you are allowed to run unlimited
virtualized instances of Windows Server 2012 under your server license.
For more details and specific license questions and pricing, contact your
Microsoft reseller.

Install Windows Server 2012

After you plan your environment, it will be time to install Windows
Server 2012. The installation process is fairly straightforward. This is
mainly because of the role-based nature of Windows Server 2012. You
will learn more about installing roles in Chapter 2.

Perform a Windows Server 2012 Full Installation

In this section, you will take a step-by-step look at the installation pro-
cess for a Windows Server 2012 full installation. We’ll cover the key
decisions you need to be aware of as you install the operating system.

1. Insert the DVD media into the drive and reboot the system. Make
sure your DVD is in the proper boot priority order so the DVD
boots first. Upon reboot you will see the screen shown in Figure 1.1.
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NOTE The DVD-ROM should hold boot priority over the HDD
in this instance.

Figure 1.1: Selecting your language

Windows Setup =o| 5[l

€

am Windows Server 2012

Language to install: |[English (United States) i

Time and cu 2id English (United States) i

Enter your language and other preferences a

Select your chosen language, time/currency, and keyboard
method, and then click Next. You will see the screen shown
in Figure 1.2.

Figure 1.2: Starting the installation

L Windows Setup

= Windows Server 2012

Install now
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This screen provides the option to install Windows Server 2012 by
clicking the Install Now button. The Repair Your Computer op-
tion takes you to the repair and diagnostics functions of Windows
Server 2012. To continue the installation, click the Install Now
button.

3. The next window you see (Figure 1.3) provides you with the
choice to install your edition of Windows Server 2012. You can
choose to install the Server with a GUI or the Server Core version.
Select your version, and click Next. Here is the screen for the trial
version of Windows Server 2012.

Figure 1.3: Selecting your Windows Server 2012 version

Windows Server 2012 Datacenter Evaluation (Server Core Inst.. #64 202
‘Windows Server 2012 Datacenter Evaluation (Server with a GUI) x64 Taefama
Deccription:
This option [re reduces and servicing by installing only what is needed

to run most server roles and applications. It does not include & GUI, but you can fully manage the
senver locally or remotely with Windows PowerShell or other tools. You can switch to a different
installation option later. See "Windows Server Installation Options.”

NOTE Depending on the version of Windows Server 2012
you are installing, you may not see the screen in Figure 1.3
initially. You may see a screen prompting you for a product key.
After you type in the product key, you will see your installation
options based on the key you entered.

4. Clicking the Next button takes you to the License Agreement
screen. This screen, shown in Figure 1.4, allows you to read, print,
and agree to the license terms. Select the check box on the bottom
left of the dialog box to agree to the license terms, and click Next
to continue.
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Figure 1.4: Licensing terms

License terms

MICROSOFT SOFTWARE LICENSE TERMS
MICROSOFT WINDOWS SERVER 2012 DATACENTER
These license terms are an agreement between Microsoft Corporation (or based on
wihere you live, one of its affiliztes) and you. Please read them. They apply to the
software named above, which includes the media on which you received it, if any. The
terms also apply to any Microsoft

updates,

supplements,

Internet-based services, and

support services w

Mest

5. The screen shown in Figure 1.5 provides you with the choice
between performing an upgrade or custom installation of
Windows Server 2012. To perform a new installation, click
Custom, and you will be taken to the next step.

Figure 1.5: Upgrading or customizing

Which type of installation do you want?

Upgrade: Install Windows and keep files, settings, and applications
The files, settings, and applications are moved to Windows with this optien. This option ic enly
available when a supparted version of Windows is already running on the computer,

Custom: Install Windows enly (advanced)

The files, settings, and applicaticns aren't maved ta Windaows with this cption. I you want to
make changes to partitions and drives, start the comnputer using the installation disc, We
recommend backing up your files before you continue.

Help me decide

6. The next screen, displayed in Figure 1.6, allows you to choose the
location for your Windows Server 2012 installation. This screen
also allows you to load drivers for your SCSI hard drives.

15
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If you are installing on a hard drive connected to a SCSI control-
ler, select Load Driver, and insert the media with the drivers on
it. You also have a full set of drive partitioning and formatting
options, as shown in Figure 1.6. When you click the installation
drive and click Drive options (advanced) for Windows Server
2012, you are presented with the options to create new partitions
or delete, format, or extend existing partitions. Choose the
appropriate option for your system, and click Next. If you do

not select a partition and the only option you have is unallocated
space, the Windows Server 2012 installation will create a parti-
tion on that drive by taking all the unallocated space and format-
ting it for you automatically with NTFS. Windows Server 2012
will also automatically make a system partition of 200MB in size
during this step. The 200MB partition is not assigned a drive and
will not be visible in the OS. The partition holds the Windows
boot files for the Windows recovery environment (winRE).

Figure 1.6: Selecting a drive and partition

Where do you want to install Windows? I'

| Name Total size Free space | Type |

"
|.,_:‘? Drive 0 Unallocated Space L& 127.0 GB 127.0 GB |

+3 Refresh Drive options (zdvanced)

&4 Load driver

7. When you select the partition you created, the installation will
begin, and you will see a screen similar to Figure 1.7. The system
may also reboot several times during this phase of installation.
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Figure 1.7: Windows installation progress

Installing Windows

Your computer will restart several times. This might take a while.

4 Copying Windows files
Getting files ready for installation (0%)

Finishing up

After the final system reboot, you will be asked to configure the
administrator’s password, and you will see a screen similar to
Figure 1.8.

Figure 1.8: Initial change of password logon

Settings

Typ for the built-in adminis

rname

ord

leenter password

Set your administrator password. The password needs to be com-
plex. This means the initial password needs to meet the following
requirements:

Cannot contain the user’s account name or parts of the user’s full
name that exceed two consecutive characters
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= Beatleast six characters in length
=  Contain characters from three of the following four categories:
»  English uppercase characters (A through Z)
»  English lowercase characters (a through z)
= Base 10 digits (0 through 9)
»  Nonalphabetic characters (for example, !, $, #, or %)

There is also an option for you to create a password reset disk. By
clicking this option, you can create a recovery disk, which allows
you to create a new password for the user ID. You create this disk
only once, no matter how many times the password for the
account changes.

9. After you set the password, you will see a screen similar to
Figure 1.9.

Figure 1.9: Logon window

Fress Ctrl+Alt+Delete

252

Wednesday, November 7

After you have set the password, the Windows Server 2012 installa-
tion will complete, and you will see a new screen with the new version
of Server Manager, as shown in Figure 1.10.
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Figure 1.10: Server Manager

Sarver Manager = [o -

'WELCOME TO SERVER MANAGER

o Canfigure this local server

QUICK START

WHATS NEW

Hicks
LEARN MORE

ROLES AND SERVER GROUPS
Ravie] | Sewer gieops 1 | Sen

1 B Local server 1

Perform a Windows Server 2012 Server Core
Installation

Installing Windows Server 2012 Server Core follows a process similar
to the previous steps. The only difference comes in step 3; here you
would select Server Core Installation instead of Server with a GUI for
your edition of Windows. You will learn how to add roles in

Chapter 2.

Use sconfig to Configure Your Windows
Server 2012 Server Core

After you install Windows Server 2012 Server Core, you need to con-
figure the basics of the server, such as the network settings, computer
name, domain membership, and so on. In prior versions of Windows
Server, you had to be familiar with the netsh commands in configuring
these aspects of Server Core.

Although you can still configure the Server Core installation
with netsh commands as you may have done in the past, by default
PowerShell is installed on a Windows Server 2012 core installation and
you can begin your management with PowerShell. We will take a look

19
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at PowerShell in Chapter 3, “Automating Administrative Tasks with
Windows Server 2012.” You can also leverage Server Configuration.
Server Configuration is a DOS-style menu configuration system that
provides simple commands for configuring your server. This tool allows
you to complete these common tasks easily. After you log on to Server
Core, type sconfig. You will see a screen similar to Figure 1.11.

Figure 1.11: Server Configuration tool

Administrator: C\Windows\system32\cmd.exe - sconfig

Windows Update
) I

Not participating

Enter number to select an option: _

As you can see, this tool is very easy to follow. For example, if you
want to change the network settings after you have launched sconfig,
press the 8 key to configure the settings. Then you will just need to fol-
low the menu screens to finish the configuration.

If you do not want to use sconfig, PowerShell, or the command
prompt, you can add the GUI management components. Adding the
GUI management components provides an easy and familiar way to add
and remove server roles and features. What makes Server Core great in
Windows Server 2012 is that you can add the GUI, configure the server,
and then easily remove it.

To start a PowerShell on a Server Core, type Powershell at the com-
mand prompt. To install the GUI features, you will first need to mount
the installation files:

1. Make a mount directory for the installation files. From within a
PowerShell session, type Mkdir c:\mount.
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2. Mount the source files, In this example, the files are mounted from
the Windows Server 2012 installation in the D: drive. By defaul,
you can use index 1:

Mount -WindowsImage -ImagePath d:\sources\install.wim
-Index 1 -Path c:\mount -readonly

Once you have mounted the files, you can use one of the two com-
mands to install the GUI components:

= To Install the full Windows Server 2012 GUI, run the following
PowerShell command:

i Getting Started
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Install-WindowsFeature Server-Gui-Mgmt-Infra,
Server-Gui-Shell -Restart -Source c:\mount\windows\winsxs

= ToInstall the Minimal Server Interface, run the following
PowerShell command:

Install-WindowsFeature Server-Gui-Mgmt-Infra
-Restart -Source c:\mount\windows\winsxs

Likewise, if you have installed a full server GUI, you can also remove
the GUI and convert your installation to a Windows Server Core instal-
lation. You do that by using the Remove Roles and Features Wizard. To
remove the GUI, follow these steps:

1. Open Server Manager from the Start screen.
Click Manage on the top toolbar.
Click Remove Roles and Features.

Click Next on the default page.

o @ N

Select the local server from which you want to remove the GUI
and click Next.

On the Server Roles page, click Next.
On the Features page, find User Interfaces and Infrastructure.

Expand the User Interfaces and Infrastructure.

© ® N 9

To remove the full server GUI, deselect Graphical Management
Tools and Infrastructure and Server Graphical Shell and then click
Next.

10. Verify the information on the Confirm installation selections
screen and then click Remove.

11. Verify the results and then click OK. Your server will need to be
restarted to complete the conversion to Server Core.
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Activating Windows Server Core

When you install Windows Server 2012 on a server with a GUI
installation or Server Core, you must activate the operating
system to ensure you have a valid product. Activation also
enables your copy of Windows Server 2012 to function properly.
On a full server installation, the Activate Windows Wizard

is located in the Control Panel. This simple wizard takes you
step-by-step through the process. However, there is no wizard
in a Server Core installation of Windows Server 2012, so you
will have to run one of the following two commands to activate
the operating system.

= If you entered the product key for your Server Core installation
during the install process, run this script:

cscript C:\windows\system32\slmgr.vbs -ato

» If you did not enter the key during the install process, run the
following command:

cscript C:\windows\system32\slmgr.vbs -ipk <product key>

When the script finishes execution, run this command to activate
Windows:

cscript C:\windows\system32\slmgr.vbs -ato

Upgrade to Windows Server 2012

Upgrading to Windows Server 2012 can require some additional plan-
ning and consideration because Windows Server 2012 is released only in
64-bit versions. You cannot upgrade an x86-based system to Windows
Server 2012. You can only perform a migration, which will be covered
in the next section. Your current operating system and edition will
determine the proper path for your upgrade. However, when you
perform an upgrade, the process is really an in-place migration under
the covers. Table 1.6 shows the paths you can take. If your current
operating system is not listed, it is not supported.



Table 1.6: Upgrade Paths

Install Windows Server 2012

Existing Windows Operating System

Windows Server 2012 Upgrade
Options

Windows Server 2008 Standard with SP2
or Windows Server 2008 Enterprise with
SP2

Windows Server 2008 Datacenter with SP2
Windows Web Server 2008

Windows Server 2008 R2 Standard with
SP1 or Windows Server 2008 R2 Enterprise
with SP1

Windows Server 2008 R2 Datacenter with
SP1

Windows Web Server 2008 R2

Windows Server 2012 Standard, Windows
Server 2012 Datacenter

Windows Server 2012 Datacenter
Windows Server 2012 Standard
Windows Server 2012 Standard, Windows

Server 2012 Datacenter

Windows Server 2012 Datacenter

Windows Server 2012 Standard

Performing an in-place upgrade is a destructive process in a sense.
You are replacing the existing server operating system with the new
one—and this is a one-way street. If the upgrade process goes awry, you
will incur downtime until you resolve the issue and restore your system.
Before you perform any upgrade or migration, back up your existing
server operating system and data. To perform an in-place upgrade,

follow these steps:

1. Insert the DVD media into the drive. The screen shown in

Figure 1.1 displays.

2. When you click Install Now, you will be presented with a couple
of choices, as shown in Figure 1.12. You can choose to partici-
pate in the Microsoft Customer Experience program by selecting
I Want To Help Make Windows Installation Better. This pro-
gram helps Microsoft identify trends for successful and unsuc-
cessful installations and determine which updates are needed.
Choosing to participate is strictly optional. You can learn more
about the program by clicking What Information Will Be Sent To

Microsoft?
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Figure 1.12: Installation updates

Get important updates for Windows Setup

Go online to install updates now {recommended)
(Gex the latest updstes, such as securky updstes and hardware drivess, to help successfuly
install Windews, (Your computer will sty connected to the Intemet while Windows ot}

Mo thanks
"Withaut these updstes, Windows might not install propersy snd your computer might be mare
vulnersbile to security thrests,

I Iwerz te help make the Windows instalation Etter

Erniacy statement

You will also be presented with a choice to upgrade your installa-
tion files. You should always choose to update them; the following
updates are included in this choice:

» Installation updates
=  Driver updates
»  Windows updates

= Microsoft Windows Malicious Software Removal Tool
updates

If you choose to go online and update your installation, you will
see a screen similar to Figure 1.13 while downloading the updates.
After you’re done downloading them, or if you choose not to up-
date the installation, you will proceed to the next step.

Figure 1.13: Update installation progress

Searching for updates

Your computer needs to stay connected to the Internet while Windaws installs.
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The next step provides you with the choice to install the edition of
Windows Server 2012. You can choose to install the full edition of
Windows Server 2012 or the Server Core version. Select your ver-
sion, and click Next.

When the License Agreement screen appears, you can read, print,
and agree to the license terms. Select the check box on the bottom
left of the dialog box to agree to the license terms, and click Next
to continue.

The next step offers you the choice between performing an
upgrade or custom installation of Windows Server 2012. To
proceed to the next step of the upgrade, you need to choose the
upgrade option.

The Windows Server 2012 installation will perform a compat-
ibility check, and you will see a screen similar to Figure 1.14. The
report will be saved to your desktop, and you will see what devices
will be affected by the Windows Server 2012 upgrade. Click Next
to continue.

Figure 1.14: Compatibility report

Compatibility report (saved to your desktop)

/i, Eefore continuing, make sure the app vendors support your applications on
Windows Server 2012, Follow their specific recommendations before and after
Windows installs. To make sure your app i= compatible and to download
tools and documentation, go to hitpsigo.microsoft.com/fwlink/?

Linklcl=243105
Trnpaortant: 1f the software isn't compatible with Windows Server 2012 or if the
app vendor deesn't support the app, uninstall it before you install Windows. 17

you dan't uninstall the applications, your system won't be supported, the app
might not wark, and settings or other informatian might be lost.

A Installing Windows will affect these devices:

7. The Windows Server 2012 upgrade will continue to the next step,

and you will see a screen similar to Figure 1.15. During this phase
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of installation, all the necessary files, settings, and programs
needed for the upgrade will be collected and analyzed. The system
may also reboot several times during this phase of installation.

Figure 1.15: Upgrading Windows progress

Upgrading Windows

Your computer will restart several times, This might take a while,

Copying Windows files (03)

‘Your upgrade may take a while to complete.

8. After the final system reboot, the upgrade will be complete, and
you will be presented with a Login screen. Log in, and you will
finish the upgrade. You can also review the compatibility report
again; it is located on the desktop. The file will be called windows
Compatibility Report.htm.

Install Windows Server 2012 Server Unattended

You can also perform an unattended installation of Windows Server
2012. This provides a useful method to rapidly deploy new servers in
your environment. Unattended installs are completed by creating an
answer file. The answer file is the file containing the main configura-
tions for the Windows Server 2012 installation. Settings can include
application configuration, such as configuring the home page in Internet
Explorer and controlling the desktop look-and-feel settings. To cre-

ate an answer file, you first need to install the Windows Automated
Installation Kit (WAIK). The WAIK is available in the MDT Toolkit,
located here:



Install Windows Server 2012

http://www.microsoft.com/en-us/download/details.aspx?id=25175

After you download the MDT, install the tool by clicking the MSI
file and step through the wizard, accepting the defaults.

Install the WAIK

The WAIK is a flexibility utility tool that allows you to customize your
Windows Server installs. You can also create the necessary files to assist
with configuration and deployments. To install the WAIK, you need to
install the .NET framework feature. You can find it in the Add Roles
and Features Wizard in Server Manager.

iy
o

—
-—

12.

© ® N o g R~ W N2

Open Server Manager.

Click Dashboard.

Click Add Roles And Features.

Click Next on the default page.

Select Role-based or feature-based installation and click Next.
Select the local server and click Next.

On the Server Roles page, click Next.

On the Features page, find .NET Framework 3.5 Features.
Expand the NET Framework 3.5 Features.

Select NET Framework 3.5 Features (includes NET 2.0 and 3.0)
and click Next.

. Verify your selection on the Confirm installation selections screen

and click Install.

Verify the results and click OK. The server may need to be
restarted to complete the installation.

After you have installed the MDT, go to the Start screen, begin typ-
ing Deployment Workbench, and then click the Deployment Workbench
icon in the results.
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Where's the Start Menu?

You might have noticed that Windows Server 2012 has no Start
menu. When you press the Windows key on your keyboard, a
screen similar to the one shown here appears.

Administrator &

Although you probably will not use the Start screen very fre-
quently, you might have to venture into it. If you do, my advice is
to just type what you want to find. The Start screen has built-in
search capabilities and, when you start typing, you'll get a list of
applications installed on the server. For example, if you are look-
ing for the Administrative Tools group, just start typing adminis-
trative tools and see what happens. Alternatively, type cmd and
see what happens. You will find the Start screen is useful, but
for server management, you probably will not need to look any
further than the new Server Manager. (You'll learn about Server
Manager at the end of this chapter. You're going to love it!)

1. In the Navigation pane of DeploymentWorkbench, expand the
Deployment Workbench and then expand the Information Center.

2. Select Components and then select Windows AIK from the
Components pane.

3. Click Windows AIK to download the files. After the files (approxi-
mately 1GB) are downloaded, you should see a screen similar to
Figure 1.16. Click Install.
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Figure 1.16: Welcome to WAIK
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Click Next on the Welcome screen.
Click Next after you accept the license agreement.

Pick a drive and directory for the tools. (The tools require about
1.2GB of drive space.) Then click Next.

Click Next to begin to the installation, and click Close on the final
screen.

Create an Answer File

After you have installed the WAIK tools, your next step is to create an
answer file. The file contains configuration settings for Windows and
provides the settings to your preferred desktop. To create an answer file,
you will use the Windows System Image Manager (SIM). Before you
create an answer file, you will need to load the install.wim file from the
Windows Server 2012 DVD. The file is located in the sources directory.
Copy the file to a local directory—for example, c:\source.

1.

Start Windows SIM by going to the Start screen and typing
Windows System Image Manager, and select it when it appears in the
results list.

In Windows SIM, select File > Select Windows Image, and navi-
gate to the directory that contains the install.wim file.
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3. After you select the install.wim file you located in step 2, you will
be presented with the dialog box shown in Figure 1.17. Choose the
edition of Windows Server 2012 for which you are creating the
answer file and click OK.

Figure 1.17: Windows image selection

Select an image in the Windows image file:

Windows Server 2012 SERVERSTANDARDCORE
Windows Server 2012 SERVERSTANDARD
Windows Server 2012 SERVERDATACENTERCORE
Windows Server 2012 SERVERDATACENTER

(You must be an administrator of the local machine to create catalogs.)

4. After you select the edition, you will be asked to create a catalog
file; click Yes. This process can take several minutes.

5. Choose File > New Answer File, and your screen will look similar
to Figure 1.18.

Figure 1.18: WAIK
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6.

8.

Install Windows Server 2012

You will need to add and configure the many settings that fit your
needs. For more information on configuring the settings, see the
help file that comes with the WAIK toolset (waik.chm).

When you are done modifying settings in the answer file, you

will need to save the file. Select File > Save Answer File. During
the save process, the SIM tool will start a validation process. The
Validation tool ensures that your answer file is correctly formatted
and the settings are properly configured. Before you save, you

can also validate the file by selecting Tools > Validate

Answer File.

Save the answer file with the name Autounattend.xml.

Install Windows Server 2012 Unattended

After you have an answer file, it is time to install Windows. The previ-
ous process is good for single-server deployments. However, the WAIK
tools also provide resources for many deployment methods. The WAIK
toolset provides many tools to quickly deploy multiple servers via a
variety of sources. You will learn the DVD method to deploy Windows
Server 2012 unattended.

1.

Copy your answer file (Autounattend.xml) to a disc or USB flash
drive (UFD).

Insert your UFD and your Windows Server 2012 DVD into the
server you want to install.

The Windows Server 2012 setup program automatically checks
the removable media for a file called Autounattend. xml.

After the installation is complete, make sure your settings were
properly installed.

. Lastly, you need to reseal the system by running this

command:

c:\windows\system32\sysprep\sysprep.exe /oobe /
generalize /shutdown

Resealing the system removes hardware-specific and unique system
information. This is required if you plan to redeploy the image and
properly ready the system for users.
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Migrate to Windows Server 2012

Performing a server migration instead of an in-place upgrade has some
advantages you should consider. Performing a migration does require
two servers; however, this is one of the advantages. On the server you
will be migrating to, you will perform a clean install of Windows Server
2012, and clean installations exhibit more stability than upgraded
servers. Migrations also reduce the risk of downtime in your server
environment and offer a fallback plan. During migration, the server
being migrated from is still running, and if the migration fails, you can
start all over with the new server without impacting your environment.
Lastly, migration allows you to do performance and benchmark testing
prior to fully completing the migration.

Windows Server 2012 migration can be used successfully in these
three scenarios:

x86 to x64 scenarios As mentioned earlier, Windows Server 2012
is available only in 64-bit. Migration is the only method for the x86
hardware.

Virtual server to physical server and physical server to virtual
server If you are looking to virtualization for some of your
server components in your current environment, then migration is
the way to go. Likewise, if you are looking to move some of your
virtual servers to the physical systems, migration offers another
great pathway for you.

Core Server to full server and full server to Core Server As men-
tioned in Table 1.6, you can perform this type of upgrade only on
Windows Server 2012 servers. Migration is the only way to move
from a Server Core installation to a full installation of Windows
Server 2012. You can also turn a full server into a Server Core
through this process. However, make sure the roles on the full
server are supported by Server Core.

Migration can be from x86 or x64 systems and supports the follow-
ing source operating systems:

»  Windows Server 2003

»  Windows Server 2003 R2

=  Windows Server 2008 (full server only)

=  Windows Server 2008 R2 (full server or Server Core)
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NOTE Windows 2008 Server Core is not supported for migra-
tion because Server Core has no .NET Framework support.
Additionally, the system language on both the source and the
target have to be the same. For example, if the source server’s
system language is English and the target server is in Spanish,
then the migration tools will not work.

Migration can be performed for the following roles, features, set-
tings, and data:

Active Directory Domain Services (AD DS)
DNS

DHCP

File Services

Print Services

BranchCache

IP configuration

Local Users and Groups

Prior to performing the migration, you need to install the Windows
Server 2012 migration tools.

Install Windows Server 2012 Migration Tools

The migration tools are new and provide a much improved resource for
successfully migrating your environment. You will install the migra-
tion tools first on the target Windows Server 2012 server and then on
the source server. Prior to installing the migration tools, make sure the
source servers meet the system requirements listed in Table 1.7, and
verify you are, at the minimum, a member of the Administrators group
on both the target and source servers.

Table 1.7: Migration Tool System Requirements

Source Server 0S Requirements

Windows Server 2003 or ~ 25MB free drive space, .NET Framework 2.0, Windows
Windows Server 2003R2 ~ PowerShell 1.0 or later

Windows Server 2008, 23MB free drive space, Windows PowerShell or the Server
2008 R2, or 2012 Manager command-line tool (ServerManagerCmd. exe)
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First, install the migration tools on the Windows Server 2012 tar-
get server. After the tools are installed on the target server, create
deployment folders on the target server for the source server. Lastly, to
complete the installation, register the Windows Server migration tools
on the source servers. You will see how to install the tools via Server

Manager:

1.

o g A~ w N

Open Server Manager (you can also install the tools via PowerShell
if you are running Windows Server 2012 Server Core) on the target
server, click Dashboard and select Add Roles And Features.

Click Next on default page.

Select Role-based or feature-based installation and click Next.
Select the local server and then click Next.

On the Server Roles page, click Next.

On the Features menu, you may need to scroll down to select
Windows Server Migration Tools. You will see a screen similar
to Figure 1.19. After you select Windows Server Migration
Tools, click Next.

Figure 1.19: Migration features
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7. Verify the Confirm installation selections screen and click Install.

You will see a screen similar to Figure 1.20.
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Figure 1.20: Windows Server Migration Tools confirmation
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8. Verify the results and click OK. The server may need to be
restarted to complete the installation.

9. After the tools are installed, create the deployment folders on the
target computer. To do this, first you need to open an administra-
tor command prompt. Move your mouse to the lower left of the
screen and right-click. You will see a menu similar to Figure 1.21.
Select Command Prompt (Admin).

Figure 1.21: Selecting Command Prompt (Admin)

Programs and Features
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10. Create a deployment folder on the target computer to hold the

1.

12.

migration tools; the following examples use c:\migration. This
folder can also be a network path.

In the Command Prompt window, change to the Server Migration
Tools directory. The directory by default is located at c: \windows\
system32\ServerMigrationTools\ (if you installed to the default
directory on the C: drive). To get there quickly, you can enter the
command cd %windir%\system32\servermigrationtools\ and press
Enter.

Depending on what architecture and operating system your
source system is running, you will need to run one of the following
commands. The command creates a directory with the migration
tools in it, as in Figure 1.22, which shows a directory created for a
64-bit version of Windows 2003 with the name of SMT_ws03_amd64.

Figure 1.22: Windows migration directory

SILAUE= migration B
Home  Share  View v @
(e -t » Computer b Local Diskc (C) » migration v & Search migration o
r Fovorites ~| Mame Date modified Type Size
Bl Desktop SMT_ws03_amdé4 11/8/2012 2:46 PM File folder
|8 Downloads =
= Recent places
=5 Libraries
_, Documents
& Music
[ Pictures
B videos
v
1item E =

= If your server is 64-bit Windows Server 2003, type the follow-
ing command and press Enter:

SmigDeploy.exe /package /architecture amd64 /os WS03 /
path c:\migration

» Ifyour server is 64-bit Windows Server 2008, type the follow-
ing command and press Enter:
SmigDeploy.exe /package /architecture amd64 /os WS08 /
path c:\migration

s Ifyour server is x86 Windows Server 2003, type the following
command and press Enter:

SmigDeploy.exe /package /architecture X86 /os WS03/path
c:\migration



13.

14.

15.
16.
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= Ifyour server is x86 Windows Server 2008, type the following
command and press Enter:
SmigDeploy.exe /package/ /architecture X86 /os WS08 /
path c:\migration
= Ifyour server is Windows Server 2008 R2, type the following
command and press Enter:
SmigDeploy.exe /package /architecture amd64 /os WS08R2 /
path c:\migration
Copy the folder created in step 10 to a local directory on the
source computer so you can register the tools with the source
server.

On the source server, open a command prompt. If the server is
Windows Server 2003, just run the command. However, if the
source server is Windows Server 2008 or 2008 R2, you will need
to run an elevated command prompt. To do that, select Start >
All Programs > Accessories, right-click Command Prompt, and
select Run As Administrator.

Change to the directory to which you copied the files in step 13.

Type .\Smigdeploy.exe, and press Enter to register the tools. When
this command is complete, you will see a status message, and a
Windows PowerShell window will open. You will see a screen
similar to Figure 1.23.

Figure 1.23: Windows migration install
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After you install the migration tools, it will be time to perform the
migration.

Migrate to Windows Server 2012

Regardless of the feature or role you will be migrating to Windows
Server 2012, you will follow three general steps after you install
Windows Server 2012 on the new target server:

1. Export the settings from the source server to temporary storage.
2. Import the settings to the target server from temporary storage.

3. Transfer any data and shares from the source server to the target
server.

A New Server Manager

One of the new tools you will first see in your Windows Server 2012
installations is Server Manager. This tool will change not only how you
manage your local server but all of the servers in your infrastructure.
Throughout this book, you will see Server Manager in action; in this
section, you will get a brief tour of the tool.

One of the first things you will notice about the new Server Manager
is the Dashboard. The Dashboard is where you can get a quick glimpse
of your server environment. You can see an example in Figure 1.24.

Figure 1.24: Server Manager
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A New Server Manager

In the Dashboard, you see the status of all the servers and their
respective installed roles. This is designed to save you time and
administrative effort. If the category in the Roles and Server groups
is green, then all systems are normal. If the category is red, then you
most likely have some issues. From the Dashboard, you can quickly
jump to the status of the roles by clicking the role (or by clicking the
role name on the left-hand navigation tree). You then will be taken
to a screen that will show you events, best practice analyzer results, a
listing of servers running the role, performance counters, and even a
snapshot of the services that support the role. You can see an example
of the Hyper-V role in Figure 1.25. Also from the Dashboard, you can
quickly configure the local server, add roles and features, add servers
to manage, and create groups to manage your server right from the
Dashboard.

Figure 1.25: Hyper-Vin Server Manager
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Let’s take a look at managing some of the aspects of your local server.
When you click Local Server on the Navigation pane or Configure
Local Server on the home page of the Dashboard, you will see a screen
similar to Figure 1.26.
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Figure 1.26: Configure Local Server
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As you can see, all the common tasks for server management are listed
and have links to quickly manage those aspects. From changing the name
of your server or configuring the IP address to a quick overview of the
hardware, this central location allows you to quickly manage the
server.

One very important aspect of the Server Manager is the top-right menu
bar shown in Figure 1.27.

Figure 1.27: Server Manager menu bar

I’Z Manage Tools View Help

This menu bar provides three menus that offer the key to successfully
managing your servers. The first menu, represented by the flag icon, is
the Action Center. Click the icon to display a list of recent events, such
as a successful installation or additional steps taken after a role installa-
tion. You might also see potential issues here.

The next menu item is labeled Manage. From this menu, you can add
and remove server roles and features, add servers, create a server group,
and configure basic properties of the server manager.
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The last menu item, Tools, is probably going to be one of your
favorites. Click Tools to access all of the available administrative tools.
Essentially, the Tools menu is the Administrative Tools group from pre-
vious server environments.

Now, with Server Manager, you can manage multiple servers. To
do that, you need to add the servers you want to manage. (Make sure
you have administrative privileges on the servers you add.) You can add
servers using any of the three following methods:

= Active Directory
= DNS
= Import

=  To add a server, you can either right-click All Servers or click
the Manage menu and select Add Servers. When you have
done so, you will see a screen similar to Figure 1.28.

Figure 1.28: Add Servers ViaDNS
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Then choose the appropriate method for your infrastructure, click
OK, and the server will be added to the server list. One of Server
Manager’s hidden gems is that once the server is added to the list, you
have a great shortcut menu to manage the server, When you right-click
the server, you will see a screen similar to Figure 1.29.
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Figure 1.29: Server Management shortcut menu
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Not only can you add and remove roles and features remotely, you
can also open a remote desktop connection to the server. You can
create groups that will allow you to organize your servers. By going to
the Manage menu on the menu bar, you can also select Create Server
Group to create a group of servers you can easily access and manage.
After you create the server group you can then add all the servers you
want to manage; they will be grouped in the right-side navigational tree.

In this section, you just took a quick tour of the Server Manager. Do
not be afraid to explore the different options as you add roles or addi-
tional functionality to your server. Throughout the rest of this book,
you will see the Server Manager in action and learn how this tool
provides access to all of your server management needs.
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